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Thank you for purchasing your ~AC~ Keyper Doll Key. This Owner's Manual provides a clear and
detailed explanation of how to setup and use the ~AC~ Keyper Doll Key. This Owner's Manual is
divided into 14 main chapters so you can quickly find what you are looking for.
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1. INTRODUCTION

Have you ever wanted to be a wind up doll? The AC Keyper Doll Key makes it possible! You can 
role play being a wind up doll and let other people play with you, toy with you, break you or even 
take advantage of you and many other things that will be described in detail in this manual.

In order to take full advantage of all the AC Keyper Doll Key features, your Second Life viewer will
need to have RLV enabled.

The AC Keyper Doll Key packed with unique features that you will not find in any other Doll Key. 
You and those around you will have endless fun with this exceptional product.

1.1. FEATURES

Some of the most important features include:

Some of the functionality of the AC Keyper Doll Key is based on the open collar system. The open
collar elements reside in a separate prim to make alterations convenient. For more information on 
open collar see the open collar documentation in your AC Keyper Doll Key product folder.

A detailed Owner's Manual in notecard and PDF format.

An ornate doll key with a separate decorative keyhole back plate.

Separate AC Keyper Huds for doll and public so the menus are always easily accessible.

The AC Keyper Hud for the public can control multiple dolls at the same time.

A rezzable poseball so people can fully participate in the action and fun.

Poseballs automatically adjust position and rotation relative to the Doll with each new sitter.

Comes with prefab tools such as a hammer, a wrench and many others.

Prefab configuration notecards with sane values.

The ability to add your own custom animations, custom sounds and add or update custom texts 
providing a fresh experience for every body involved.

Access control so you, the doll, can determine who is allowed to interact with the doll be it the doll 
only, doll owners, or everyone.

The ability to set levels of RLV restrictions enforced on the doll or to have no RLV restrictions.

Clear and coherent error messages that inform you of the proper actions to take if something 
inadvertently goes wrong.
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The AC Keyper system is very sophisticated and consists of many scripts. Consequently a lot of 
script memory is used, which could produce lag. Therefore Angel's Creations has reduced script 
memory where ever possible to minimize lag. This improves everyone's SL experience.

Encryption of communications between the AC Keyper Doll Key, AC Keyper Huds, and AC Keyper
Pose Ball. Only your AC Keyper can communicate with AC Keyper Huds and AC Keyper Pose 
Balls so that others cannot interfere with their operation.
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2. PRODUCT FOLDER

It is HIGHLY recommended that you save your original product box. In this way you will always 
have the original versions to go back to. After you have unpacked your ~AC~ Keyper Doll Key 
product box, you will find your ~AC~ Keyper Doll Key product folder in your inventory. It contains 
the following items:

Name Description

AC Keyper The Keyper Key worn on the spine.

AC Keyper (No SubSpy) The Keyper Key without the SubSpy features.

AC Keyper Back Plate The decorative Key Hole worn on the spine.

AC Keyper Doll Hud The hud worn by the Doll.

AC Keyper Hud (Inside of the AC Keyper) The hud worn by the public.

AC Keyper Pose Ball (Inside of the AC Keyper) The pose ball people can sit on to be animated.

Animations (Inside of the AC Keyper Naughty 
prim and AC Keyper Pose Ball)

Default animations for the Keyper and poseball.

Animations BackUp Package An object containing ALL of the original default 
animations.

Sounds (Inside of the AC Keyper) Sounds for the Keyper.

Sounds BackUp Package An object containing ALL of the original default 
sounds.

AC Keyper (Tools Inside of the AC Keyper) Tools to be given to and worn by others.

AC Keyper Tools BackUp Package An object containing ALL of the original default 
tools.

AC Keyper General Configuration The notecard with general settings and winding 
related settings.

AC Keyper Button Configuration The notecard with settings for optional menu 
button choices.

AC Keyper Configuration Notecards BackUp 
Package

Back up configuration notecards with default 
sane values.

~AC~ Keyper Doll Key Owner's Manual The notecard you are reading right now.

~AC~ Keyper Doll Key Photo (1407061706) The product image.

~AC~ Keyper Doll Key Back Up Package An object with a full product back up package.

Open Collar help notecards. Various notecards to help you learn how to use 
Open Collar.

Angel's Creations, HV community (39, 32, 23) Angel's Creations main store.

Angel's Creations Business Information All about Angel's Creations.
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3. SETTING UP

From your AC Keyper Doll Key product folder wear (or add) the following items:
AC Keyper Back Plate, it attaches to your spine
AC Keyper or AC Keyper (without SubSpy), it will attach to your spine and the AC Keyper Doll 
Hud which will attach on the upper left of your viewer screen.

When you first wear your AC Keyper the configuration notecards will be read. You will see the 
following messages:
Processing the AC Keyper Button Configuration notecard ...
Processing the AC Keyper General Configuration notecard …

When they are both done and there are no errors you will see the following messages:
Finished processing the AC Keyper Button Configuration notecard.
Finished processing the AC Keyper General Configuration notecard.
This AC Keyper is ready for use.

Once you see the “This AC Keyper is ready for use.” message you can start using your AC 
Keyper Doll Key. You may get errors but still be able to use your AC Keyper, such as if you used 
duplicate button names. You can edit the configuration notecards at anytime directly from the 
inventory of the AC Keyper. Once you have edited either or both configuration notecards touch 
your AC Keyper or choose 'Menu' from your AC Keyper Doll Hud. Then choose 'Configure' from 
the dialog menu.

If you do not get “This AC Keyper is ready for use.” message then there is an error that cannot be 
overlooked. Edit either or both of the configuration notecards and fix the mentioned error then 
touch your AC Keyper. The configuration notecards will then be read again.

The AC Keyper is already setup with some configuration information filled in so you can quickly 
start using your AC Keyper Doll Key, but you change these options at any time by editing either or
both of the configuration notecards. You will also need to handle sounds and animations in the 
proper way. Please refer to chapters 4.1. and 5.1. for further information

Each time you log in to Second Life or you wear your AC Keyper you will see open collar related 
messages. You will also see open collar related messages when you, the Doll, becomes broken, 
wound down, adds an owner, or changes RLV settings via the Naughty Menu.
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4. AC KEYPER GENERAL CONFIGURATION NOTECARD

4.1. GENERAL CONFIGURATION INTRODUCTION

The name of this notecard is AC Keyper General Configuration
Do not change the name of this notecard.

To edit the AC Keyper General Configuration notecard, open the notecard by double clicking on it 
from the ~AC~ Keyper Doll Key product folder or from the AC Keyper object inventory. You can 
alter the setting Values as needed then click the 'Save' button in the notecard window.

This notecard contains Event Headers which are always capitalized and inside of square 
brackets. The Event Headers are as follows:

[WIND1], [WIND5], [WIND10], [WIND15], [WIND20], [WIND30]
[WINDINGSOUND]
[REMTIME5], [REMTIME10], [REMTIME>10]
[WOUNDDOWNANIM], [WOUNDDOWNTEXT], [WOUNDDOWNSOUND]
[OVERWOUNDANIM], [OVERWOUNDTEXT], [OVERWOUNDSOUND]
[GENERAL], [MODECHANGE]

For each Event Header there are Keyword/Value pairs and must have the following format: 
Keyword = Value

The only exceptions to the above format are lines starting with // 
These lines are comment lines.

A Set refers to the three Keyword/Value pairs for an Event Header. A Set will contain three 
phrases, animations, or sounds. Each Event Handler has one Set with the exception of 
[GENERAL].

You can have up to 3 phrases for each of the following Event Headers giving a maximum of 36 
phrases total: 

[WIND1], [WIND5], [WIND10], [WIND15], [WIND20], [WIND30]
[REMTIME5], [REMTIME10], [REMTIME>10]
[WOUNDDOWNTEXT], [OVERWOUNDTEXT], [MODECHANGE]

You can have up to 3 animations for each of the following Event Headers:
[WOUNDDOWNANIM], [OVERWOUNDANIM]

You can have up to 3 sounds for each of the following Event Headers:
[WINDINGSOUND], [WOUNDDOWNSOUND], [OVERWOUNDSOUND]

Each Event Header must include all of the related Keywords in a Set even if you do not wish to 
have a Value for the specific Keyword. The Keyword Values that are optional are: Phrase, Anim, 
and Sound.
If you do not wish to use a Value for one, two, or three of the optional Keywords in a Set then 
simply leave the Values empty but keep the = symbol.
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When it is time to output a phrase, play an animation, or play a sound the related Value is chosen 
from randomly from the related Set of an Event Header.
The Event Header of [WINDINGSOUND] is an exception. For [WINDINGSOUND] the first sound 
in the Set will be played when the remaining time (remtime) is less than 1/3 of the MaxWindTime. 
The second sound in the Set is played when remtime is between 1/3 and 2/3 of MaxWindTime. 
The third sound in the Set is played when remtime is 2/3 or more of MaxWindTime.
The remtime will include the time the Doll has already been wound for as well as the value for 
which ever wind button choice was just made. These sounds are also played for different lengths 
of time based on the wind button choice.

Each single phrase can be up to 247 characters. Place Holders are 6 characters each.
A single phrase must be typed without hitting the return or enter key. If you want part of a single 
phrase to show on a separate line use the back slash \ followed by the letter n within your 
phrase. \n

Animations must be the name of an animation inside of the AC Keyper Naughty prim inventory. 
You will need to edit linked parts of your AC Keyper to add the animations to the correct prim 
inventory.

Sounds must be a valid UUID or the name of a sound inside of the AC Keyper prim inventory.
All sounds are played at a volume of 1.0.

4.2. PLACEHOLDERS

You can use special Place Holders within your Phrases. Place holders are always capitalized and 
inside of percent symbols.

The place holders available are as follows:
%DOLL% use this for inserting your own name into a phrase.
%USER% use this for inserting the person's name who is controlling you into a phrase.
%TIME% use this for inserting the minutes remaining into the Phrases for the [REMTIME#]
Event Headers only.
%MODE% use this for inserting the textual version of the AccessMode into the Phrases for
the [MODECHANGE] Event Header only.

You can make your name or a user's name in the possessive form in the following way:
If your name ends with an s then %DOLL%'
If your name does not end with an s then %DOLL%'s
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4.3. GENERAL CONFIGURATION SETTINGS

OutputType = Say
MaxWindTime = 7200
WoundDownRestrictions = 0
BrokenRestrictions = 1
AccessMode = 0
RezPoseBall = 2
PoseBallOffset = 0.5
Phrase = Some Phrase
Anim = Some Animation Name of an animation in the AC Keyper Naughty prim.
Sound = UUID or Sound Name of a sound in the AC Keyper prim.

4.4. GENERAL CONFIGURATION SETTINGS DETAILS

[GENERAL]:

OutputType determines how far away the 'Phrases' can be seen in public. If OutputType is 
'whisper' then the Phrases will be seen in public within a range of 10 meters. If OutputType = say, 
then Phrases will be seen within a range of 20 meters.

MaxWindTime is the amount of winding time in seconds it takes to over wind the Doll. Default is 
7200 seconds (120 minutes).

WoundDownRestrictions is the RLV restriction level to set when the Doll becomes wound down. 
Must be an integer value from 0-4
Where: 0 is no restrictions, 1 is Low restrictions, 2 is Medium restrictions, 3 is High restrictions, 4 
is Extreme restrictions.

BrokenRestrictions is the RLV restriction level to set when the Doll becomes broken. Must be an 
integer value from 0-4
Where: 0 is no restrictions, 1 is Low restrictions, 2 is Medium restrictions, 3 is High restrictions, 4 
is Extreme restrictions.

AccessMode determines who can interact with the Doll. Must be an integer value from 0-2: Use 0 
for Doll Only, 1 for Everyone, or 2 for only Doll Owners.
Where Doll Owners are owners or second owners that the Doll sets via the Naughty Menu.

RezPoseBall determines who can rez an AC Keyper Pose Ball via the Menus. Must be an integer 
value from 0-2. Use 0 for Doll Only, 1 for Everyone, 2 for Doll Owners.
Where Doll Owners are owners or second owners that the Doll sets via the Naughty Menu.

PoseBallOffset is how far behind the Doll to rez the AC Keyper Pose Ball. Must be a decimal 
number between 0.1 and 2.0 
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[WIND1], [WIND5], [WIND10], [WIND15], [WIND20], and [WIND30]:

Phrase is the text that will be output when a user winds the Doll via the Wind Menu for the relative
numeric wind time.
Phrase = Some Phrase
Phrase = Another Phrase
Phrase = Yet Another Phrase
You can have up to three phrases for EACH of the six related [WIND#] Event Headers.

[REMTIME5], [REMTIME10], and [REMTIME>10]:

Phrase is the text that will be output when the Doll has already been wound and the time 
remaining before the Doll becomes wound down is:
         [REMTIME5]     less than five minutes. Output at a frequency of once per minute.
         [REMTIME10]   less than ten minutes. Output at a frequency of once per two minutes. 
         [REMTIME>10] more than ten minutes. Output at a frequency of once per five minutes.
Phrase = Some Phrase
Phrase = Another Phrase
Phrase = Yet Another Phrase
You can have up to three phrases for EACH of the three related [REMTIME#] Event Headers.

[WOUNDDOWNTEXT]:

Phrase is the text that will be output when the Doll becomes wound down.
Phrase = Some Phrase
Phrase = Another Phrase
Phrase = Yet Another Phrase

[OVERWOUNDTEXT]:

Phrase is the text that will be output when the Doll becomes over wound, which is based on the 
Value for MaxWindTime.
Phrase = Some Phrase
Phrase = Another Phrase
Phrase = Yet Another Phrase
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[MODECHANGE]:

Phrase is the text that will be output when the Doll changes the Access Mode for who is allowed 
to interact with the Doll. If you leave the Value for these Phrases blank then only you (the Doll) will
be told of the Access Mode change.
Phrase = Some Phrase
Phrase = 
Phrase = Yet Another Phrase

Notice I left one of the Values for the Keyword Phrase empty. I only want to use two of the Values 
but I must include all of the Keywords.
[WOUNDDOWNANIM]:

Anim is the name of an animation in the AC Keyper Naughty prim inventory that is played on the 
Doll when the Doll becomes wound down.
Anim = Some Animation Name of an animation in the AC Keyper Naughty prim.
Anim = Another Animation Name of an animation in the AC Keyper Naughty prim.
Anim = Yet Another Animation Name of an animation in the AC Keyper Naughty prim.

[OVERWOUNDANIM]:

Anim is the name of an animation in the AC Keyper Naughty prim inventory that is played on the 
Doll when the Doll becomes over wound.
Anim = Some Animation Name of an animation in the AC Keyper Naughty prim.
Anim = Another Animation Name of an animation in the AC Keyper Naughty prim.
Anim = Yet Another Animation Name of an animation in the AC Keyper Naughty prim.

[WOUNDDOWNSOUND]:

Sound is the sound that will be played when the Doll becomes wound down. Must be valid UUID 
or the name of a sound in the AC Keyper prim.
Sound = UUID or Sound Name of a sound in the AC Keyper prim.
Sound = Another UUID or Sound Name of a sound in the AC Keyper prim.
Sound = Yet Another UUID or Sound Name of a sound in the AC Keyper prim.

[OVERWOUNDSOUND]:

Sound is the sound that will be played when the Doll becomes over wound. Must be valid UUID or
the name of a sound in the AC Keyper prim.
Sound = UUID or Sound Name of a sound in the AC Keyper prim.
Sound = Another UUID or Sound Name of a sound in the AC Keyper prim.
Sound = Yet Another UUID or Sound Name of a sound in the AC Keyper prim.
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[WINDINGSOUND]:

Sound is the sound that will be played when the Doll is wound via the Wind Menu. Must be valid 
UUID or the name of a sound in the AC Keyper prim.
The three sounds available are played in order relative to how long the Doll has been wound for.
Sound = UUID or Sound Name of a sound in the AC Keyper prim.
Sound = Another UUID or Sound Name of a sound in the AC Keyper prim.
Sound = Yet Another UUID or Sound Name of a sound in the AC Keyper prim.
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5. AC KEYPER BUTTON CONFIGURATION NOTECARD

5.1. BUTTON CONFIGURATION INTRODUCTION

The name of this notecard is AC Keyper General Configuration
Do not change the name of this notecard.

To edit the AC Keyper General Configuration notecard, open the notecard by double clicking on it 
from the ~AC~ Keyper Doll Key product folder. You can alter the setting Values as needed then 
click the 'Save' button in the notecard window.

This notecard contains Event Headers which are always capitalized and inside of square 
brackets. The Event Headers are as follows:

[POSE], [BREAK], [FIX], [PLAY]

For each Event Header there are Keyword/Value pairs and must have the following format: 
Keyword = Value

The only exceptions to the above format are lines starting with // 
These lines are comment lines.

For the Event Headers of [POSE], [FIX], and [PLAY] a Set consists of four Keywords:
Button, Anim, Phrase, Sound

For the Event Header of [BREAK] a Set consists of five Keywords:
Button, Anim, Phrase, PoseBallAnim, Sound

Each Set MUST contain ALL (4 or 5) Keywords. If the value for a specific Keyword in a Set is not 
needed then leave the Value empty. Keep the =
You can have up to a maximum of 8 Sets per Event Header.

Each single phrase can be up to 247 characters. Place Holders are 6 characters each.
A single phrase must be typed without hitting the return or enter key. If you want part of a single 
phrase to show on a separate line use the back slash \ followed by the letter n within your 
phrase. \n

Button names are limited to 10 characters or less and must be uniquely named for each Set within
an Event Header.

Animations must be in the AC Keyper Naughty prim inventory, with the exception of the [FIX] 
Anims and the [BREAK] PoseBallAnim animations, which must be in the AC Keyper Pose Ball. 

Sounds must be a valid UUID or the name of a sound inside of the AC Keyper prim inventory.
All sounds are played at a volume of 1.0.
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5.2. PLACEHOLDERS

You can use special Place Holders within your Phrases. Place holders are always capitalized and 
inside of percent symbols.
The place holders available are as follows:

%DOLL% use this for inserting he Doll's name into a phrase.
%USER% use this for inserting the person's name who is controlling the Doll into a phrase.

You can make the Doll's name or a user's name in the possessive form in the following way:
If your name ends with an s then %DOLL%'
If your name does not end with an s then %DOLL%'s

5.3. CONFIGURATION SETTINGS

Button = The name of the button that will show in the dialog menu for a given Event Header
Phrase = Some Phrase
Anim = Some Animation Name of an animation in the AC Keyper Naughty prim. Exception is the 
Event Header [FIX]. The Anim for the [FIX] Event Header is the animation that goes into the AC 
Keyper Pose Ball.
PoseBallAnim = Some Animation Name of an animation in the inventory of the AC Keyper Pose 
Ball.
Sound = UUID or Sound Name of a sound in the AC Keyper prim.

5.4. BUTTON CONFIGURATION SETTINGS DETAILS

You can have up to 8 Sets for each Event Header. All Keywords must be included in a Set even if 
there is no Value for the Keyword.

[POSE]

The [POSE] Event Header information is what the Animations Menu is constructed from. The 
Animation Menu is where a user can choose different positions to put the Doll in. Each Set will 
correlate to a button in the Animations Menu. When a user chooses the button then any Anim, 
Phrase, and Sound included in the related button Set will be played on the Doll, output, or played 
as a sound.
Each Set within this Event Header must have a unique button name.

Example Set One:
Button = Button01
Anim = The name of an animation in the AC Keyper Naughty prim inventory.
Phrase = Some cute or funny words here.
Sound = A valid UUID or the name of a sound in the AC Keyper prim inventory.
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Example Set Two:
Button = Button02
Anim = The name of an animation in the AC Keyper Naughty prim inventory.
Phrase = Some cute or funny words here.
Sound = 

Notice in Set Two I left the Value for Sound empty. I do not want a sound to play for this button 
choice but again, all Keywords must be included in a Set.

[BREAK]

The [BREAK] Event Header information is what the Break Menu is constructed from. The Break 
Menu is where a user can choose how to break a Doll. Each Set will correlate to a button in the 
Break Menu. When a user chooses the button then any Anim, Phrase, and Sound included in the 
related button Set will be played on the Doll, output, or played as a sound.
The PoseBallAnim animations for this Event Header are animations that will be played on the user
of the Doll if the user is sitting on the AC Keyper Pose Ball. These animations must be in the 
inventory of the AC Keyper Pose Ball. Each Set within this Event Header must have a unique 
button name.

Example Set One:
Button = Button01
Anim = The name of an animation in the AC Keyper Naughty prim inventory.
Phrase = Some cute or funny words here.
PoseBallAnim = The name of an animation in the AC Keyper Pose Ball inventory.
Sound = A valid UUID or the name of a sound in the AC Keyper prim inventory.

Example Set Two:
Button = Button02
Anim = The name of an animation in the AC Keyper Naughty prim inventory.
Phrase = Some cute or funny words here.
PoseBallAnim = 
Sound = A valid UUID or the name of a sound in the AC Keyper prim inventory.

Notice in Set Two I left the Value for PoseBallAnim empty. I do not have an animation for this 
button choice for the pose ball but I must use all Keywords in a Set.
Also notice, I used different button names for each Set within this Event Header.

NOTE
There are two optional predefined buttons names for the [BREAK] Event Header:

OverWind has the same effect as the Doll becoming over wound via the Wind Menu
choices and reaching MaxWindTime.
WindBack will cause the AC Keyper to spin in the opposite direction at a high rate.
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[FIX]

The [FIX] Event Header information is what the Repair Menu is constructed from. The Repair 
Menu is accessible from the Broken Menu once the Doll has wound down or is broken. Each Set 
will correlate to a button in the Repair Menu. When a user chooses the button then any Phrase 
and Sound included in the related button Set will be output or played as a sound.
The Anim animations for this Event Header are animations that will be played on the user of the 
Doll if the user is sitting on the AC Keyper Pose Ball. They must be in the inventory of the AC 
Keyper Pose Ball. Use clever button names so the user knows which Repair Menu button would 
make sense with how the doll is currently being animated. Each Set within this Event Header 
must have a unique button name.

Example Set One:
Button = UniqueName
Anim = The name of an animation in the AC Keyper Pose Ball inventory.
Phrase = Some cute or funny words here.
Sound = A valid UUID or the name of a sound in the AC Keyper prim inventory.

[PLAY]

The [PLAY] Event Header information is what the Play With Menu is constructed from. The Play 
With Menu is accessible from the Broken Menu once the Doll has wound down or is broken. This 
menu is intended for a user to be able to choose to pose or animate the Doll in a more 
meddlesome way. Each Set will correlate to a button in the Play With Menu. When a user 
chooses the button then any Anim, Phrase, and Sound included in the related button Set will be 
played on the Doll, output, or played as a sound. Each Set within this Event Header must have a 
unique button name.

Example Set One:
Button = UniqueName
Anim = The name of an animation in the AC Keyper Naughty prim inventory.
Phrase = Some cute or funny words here.
Sound = A valid UUID or the name of a sound in the AC Keyper prim inventory.

That's it for the configuration notecards. Anytime you grow tired of a phrase or get new fun 
animations you can update the configuration notecards and enjoy the new experience.
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6. RLV RESTRICTION LEVELS

There are four RLV restriction levels available for the Keywords BrokenRestrictions and 
WoundDownRestrictions in the AC Keyper General Configuration notecard. There is also the 
option to have none of the RLV restrictions. These restriction levels allow you, the Doll, to 
determine which group of RLV settings are set as forbidden when the Doll is broken or wound 
down. The Value of these Keywords can be an integer value from 0 to 4. Where 0 is no RLV 
restrictions, 1 is Low RLV restrictions, 2 is Medium RLV restrictions, 3 is High RLV restrictions, 
and 4 is Extreme RLV restrictions.

The details of the RLV restriction levels are as follows:
Low:

teleporting, maps, location, sitting/standing, flying,
touching more than 1.5 meters away, hovertext

Medium: in addition to Low:
adding/removing attachments and clothing,
relay set to auto, allow
playful and trust landowner objects

High: in addition to Low and Medium:
seeing names, inventory, rezzing, editing
sending: emotes/chat/instant messages,

Extreme: in addition to Low, Medium, and High:
access to dialog menus,
seeing: emotes/chat/instant messages

NOTE:
If the Access Mode is set to Doll Only and the Doll becomes broken or wound down, the Doll will 
be able to Repair, Wind Up, or Release itself unless the RLV restriction level is set to Extreme. In 
which case the Doll will not be able to access dialog menus or touch anything.
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7. MENUS

7.1. DOLL MENUS

The following dialog menu choices are available from the main Doll menu and from subsequent 
menus available to the Doll.

     a.  Animate
          Produces the Animate Menu where you can choose from the various Pose buttons setup
          via the AC Keyper Button Configuration notecard.
     b.  Wind Up
          Produces the Wind Menu where you can choose from six different times in minutes to wind
          the AC Keyper Doll Key.
     c.  Break
          Produces the Break Menu where you can choose from the various Break buttons setup via
          the AC Keyper Button Configuration notecard.
     d.  Naughty
          Produces the Open Collar Menu.
     e.  Appearance
          Produces the Appearance Menu where you can choose from different settings to affect the
          appearance of your AC Keyper Doll Key.
     f.   Mode
          Produces the Access Mode Menu where you can choose who is allowed to interact with the
          Doll. Everyone, Doll Only, or Doll Owners. The current Access Mode will show in the
          message of the Mode Menu. The Naughty feature is only available to the Doll and (when
          the Doll is broken or wound down) Doll Owners. No one else will have access to the
          Naughty feature regardless of the Access Mode.
     g.  Send Hud
          Produces the Avatar Selection Method Menu where you can choose to give an AC Keyper
          Hud to someone either by choosing 'Scanner' or 'Type Name'.
     h.  See Owners
          Outputs the owners and secondary owners of the Doll.
     i.   Reset
          Resets all of the AC Keyper scripts.
     j.   PoseBall
          Produces the PoseBall Menu where you can choose to Rez an AC Keyper Pose Ball or
          DeRez all AC Keyper Pose Balls.
     k.  Configure
          Re-reads the AC Keyper General Configuration and AC Keyper Button Configuration
          notecards. You must have these two notecard re-read in order for changes in the notecards
          to take effect.
     l.   Tools
          Shown on the Broken Menu which is shown once the Doll is broken or wound down.
          Produces the Tools Menu where you can choose to receive various Tools to hold.
     m. Play With
          Shown on the Broken Menu, which is shown once the Doll is broken or wound down.
          Produces the Play With Menu where you can choose from the various Play buttons setup
          via the AC Keyper Button Configuration notecard.
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     n.  Stop Anim.
          Shown on subsequent menus and stops the currently playing animation for the Doll.
     o.  Repair
          Shown on subsequent menus when the Doll is broken or wound down. Produces the Repair
          Menu where you can choose from the various Fix buttons setup via the AC Keyper Button
          Configuration notecard.
     p.  Release
          Shown on subsequent menus when the Doll is broken or wound down. This is a direct
          repair of the Doll. The currently playing animation is stopped and RLV restriction settings
          are restored to unrestricted settings. If the Doll was broken (not over wound or wound
          down) the AC Keyper will resume turning and counting the time down. The following
          message is output:  The 'Doll Name' Doll has been released from any AC Keyper RLV
          restrictions. The last animation has been stopped.
     q.  Main
          Shown on subsequent menus and returns you to the Doll Menu.
     r.   Back
          Shown on subsequent menus while the Doll is broken or wound down and returns you to
          the Broken Menu.
     s.  Cancel or --- or -- Cancel --
          Closes the current Menu and stops internal script timers without any action taking place.

7.2. AVATAR SELECTION METHOD MENU

This menu will display when you have chosen 'Send Hud' from the Doll Menu.

     a.  Scanner
          Automatically detects up to 16 avatars in the same region and within a 20 meter range of
          you then produces the Avatar Scanner Menu.
     b.  Type Name
          Allows you to type the name of an avatar within 64 meters of you on channel 22. You must
          type the avatar's legacy name NOT their display name. Be sure to use the appropriate
          upper and lower case of the avatar's legacy name. If you mistype or misspell the intended
          recipient name you will be told there is no avatar in range by that name and the Avatar
          Selection Menu will display again so you can try again or '-- Cancel --'.
          Example: /22 AngelAcuteAngle Jupiter
     c.  -- Cancel -- or ---
          Closes the Menu and stops internal script timers without any action taking place.

Copyright 2014 (c) Angel's Creations



7.3. AVATAR SCANNER MENU

This menu will display when you have chosen 'Scanner' from the Avatar Selection Method Menu 
or when a user is using an AC Keyper Hud and there is more than one Doll in the area. The 
buttons will have numbers that correspond to the menu text of avatar names.

     a.  Numbers
          Numbered buttons corresponding to the menu text of nearby avatar names.
     b.  -- Main -- or -- Back -- or -- Next --
          Menu paging buttons which allow you to move to the main (first page), previous, or next
          page of numbered buttons.
     c.  -- Cancel -- or --
          Closes the Menu and stops internal script timers without any action taking place.

7.4. NAUGHTY MENU

See the open collar documentation in your AC Keyper Doll Key product folder.

7.5. PUBLIC MENUS

The following dialog menu choices are available from the main Public menu and from subsequent 
menus available to the Public. The Public being anyone who is allowed to interact with the Doll 
based on the Access Mode. If the Access Mode is set to 'Everyone' then everyone can use the 
Public Menus with the exception of the Naughty option. If the Access Mode is set to 'Doll Owners' 
then only those whom the Doll specifically added as an owner or second owner via the Naughty 
option can access the Public Menus. If the Access Mode is set to 'Doll Only' then no one can 
access the Public menus.

     a.  Animate
          Produces the Animate Menu where a user can choose from the various Pose buttons setup
          via the AC Keyper Button Configuration notecard.
     b.  Wind Up
          Produces the Wind Menu where a user can choose from six different times in minutes to
          wind the AC Keyper Doll Key.
     c.  Break
          Produces the Break Menu where a user can choose from the various Break buttons setup
          via the AC Keyper Button Configuration notecard.
     d.  Naughty
          Shown on the Broken Menu which is shown once the Doll is broken or wound down.
          Produces the Open Collar Menu. Only Doll Owners, users who have been added as owners
          or second owners of the Doll, will be able to use the Naughty feature.
     e.  Get Hud
          Gives the user an AC Keyper Hud.
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     f.   PoseBall
          Rezes an AC Keyper Pose Ball depending on the setting for RezPoseBall in the AC Keyper
          General Configuration notecard.
     g.  Tools
          Shown on the main Public Menu as well as the Broken Menu, which is shown once the Doll
          is broken or wound down. Produces the Tools Menu where a user can choose to receive
          various Tools to hold.
     h.  Play With
          Shown on the Broken Menu, which is shown once the Doll is broken or wound down.
          Produces the Play With Menu where a user can choose from the various Play buttons setup
          via the AC Keyper Button Configuration notecard.
     i.   Stop Anim.
          Shown on subsequent menus and stops the currently playing animation for the Doll.
     j.   Repair
          Shown on subsequent menus when the Doll is broken or wound down. Produces the Repair
          Menu where a user can choose from the various Fix buttons setup via the AC Keyper
          Button Configuration notecard.
     k.  Release
          Shown on subsequent menus when the Doll is broken or wound down. This is a direct
          repair of the Doll. The currently playing animation is stopped and RLV restriction settings
          are restored to unrestricted settings. If the Doll was broken (not over wound or wound
          down) the AC Keyper will resume turning and counting the time down. The following
          message is output:  The 'Doll Name' Doll has been released from any AC Keyper RLV
          restrictions. The last animation has been stopped.
     l.   Main
          Shown on subsequent menus and returns the user to the main Public Menu.
     m. Back
          Shown on subsequent menus while the Doll is broken or wound down and returns the user
          to the Broken Menu.
     n.  Cancel or ---
          Closes the current Menu and stops internal script timers without any action taking place.
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8. CHAT COMMANDS

The AC Keyper listens on the public channel to only the Doll. There are two chat commands 
available to the Doll: runaway and the Doll's open collar safeword. By default the safeword is 
RED.
Using the runaway command will set RLV restrictions to not restricted and will remove any and all 
owners set in the Naughty Menu.
To use the runaway command type on the public channel your avatar initials followed by runaway.
Example: ajrunaway
Using the safeword command will set RLV restrictions to not restricted and notify any owners of 
the safeword having been used.
To use the safeword command type on the public channel your safeword. The safeword can be 
changed via the Naughty Menu. See the open collar documentation included in your AC Keyper 
Doll Key product package.

For security reasons the open collar is not directly accessible to anyone via chat commands. 
However, if the Doll chooses the Naughty Menu or the Doll is broken or wound down and a Doll 
Owner chooses the Naughty Menu, then, depending on how you set your open collar up, anyone 
can use Open Collar chat commands.
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9. HUDS

The AC Keyper Huds allow for the Doll or for a user to interact with the Doll directly from their 
worn hud. This is great if the Doll is in a position where their AC Keyper is not easily accessible.
By default both the AC Keyper Doll Hud and the AC Keyper Hud are worn as a hud attachment on
the top left of the viewer window.

9.1. AC KEYPER DOLL HUD

Locate the AC Keyper Doll Hud in you AC Keyper Doll Key product folder. Right click on it and 
choose 'wear'. The button options on this hud do exactly the same thing as the Doll Menus 
options with a few exceptions. The Menu button behaves in the same way as the Main or Back 
buttons in the Doll Menus. The Access Mode section of the hud is the top right. You can change 
the Access Mode directly by clicking on Doll, Owners, or Everyone. The current Access Mode will 
have a solid radio button to the left. The Access Mode will always be kept current on your hud no 
matter if you change it via the hud or directly via your AC Keyper. If you select a button option that
is not available for the Doll's status, such as the Doll is not broken or wound down and you select 
'Play With' or 'Repair' you will be told that option is not available.

9.2. AC KEYPER HUD

A user can obtain an AC Keyper Hud by choosing Get Hud from the Public Menus. The user will 
be given the hud. They can then wear the AC Keyper Hud directly from their viewer inventory. The
button options on this hud do exactly the same thing as the Public Menus options. When a user 
chooses a button on the AC Keyper Hud, the hud searches for nearby Dolls. If there are multiple 
Dolls nearby then the user will given an Avatar Scanner Menu where they can pick which Doll to 
interact with. The AC Keyper Hud can control multiple dolls at the same time.
A Doll cannot use an AC Keyper Hud to access their own AC Keyper Doll Key. A Doll can use the 
AC Keyper Hud to interact with other nearby Dolls.

9.3. AC KEYPER HUD PERMISSIONS

It is HIGHLY recommended that you set the Next Owner Permissions on the AC Keyper Hud to 
Yes Modify, Yes Copy, No Transfer. This is so the user can still re-size the hud but not pass it on 
to third parties that you might not want to have the AC Keyper Hud. You can do this by right 
clicking on the AC Keyper Hud in the inventory of your worn AC Keyper, choose properties then at
the bottom of the properties window where it says 'Next owner' check Modify and Copy. Uncheck 
Transfer.
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10. TOOLS

Tools allow a user to have more realistic and fun interactions with the Doll.

10.1. TOOL NAMING AND MENU BUTTONS

Tools need to be added to the inventory of the AC Keyper prim. If any tool has current owner 
permissions (permission for YOU) of No Modify then you will have to rez your AC Keyper Doll Key
on the ground in order to add the tools to the inventory. You can have up to ten tools. Tools MUST 
be named in a specific way. The name MUST start with AC Keyper followed by the tool name. The
tool names are what will show on the dialog buttons of the Tools Menu.
For example if you have a Saw that you want to use as a tool then name it AC Keyper Saw. Then 
in the Tools Menu a user will see a button with the name 'Saw'. Make sure the tools names are 
less then ten characters. If you are adding or changing tools to your AC Keyper you may need to 
delete other tools from the inventory of the AC Keyper because only the first ten tools will show in 
the Tools Menu.

10.2. TOOL PERMISSIONS

You must have Owner Permissions of Yes Copy and Yes Transfer on any item used as a tool in 
the AC Keyper Doll Key. It is recommended that you set Next Owner Permissions to No Modify, 
Yes Copy and No Transfer.

10.3. TOOL USE

The AC Keyper tools are available in the Tools Menu which can be reached via the Public Menu 
or the Broken Menu.  When a user chooses a tool from the Tools Menu they will be given that tool.
The user can then choose to wear the tool from their viewer inventory. All of the tools provided 
with the AC Keyper Doll Key are worn on the right hand by default.
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11. AC KEYPER POSEBALL

11.1 POSEBALL SETUP

The Anim animations for the [FIX] Event Header and the PoseBallAnim animations for the 
[BREAK] Event Header from the AC Keyper Button Configuration notecard MUST be in the 
inventory of the AC Keyper Pose Ball. You must have Copy permissions for any animation added 
to the AC Keyper Pose Ball. Once you have added all needed animations to the AC Keyper Pose 
Ball, put the AC Keyper Pose Ball into the inventory of the AC Keyper prim. If any of your 
animations are No Modify then you will have to rez your AC Keyper Doll Key on the ground before
being able to add the AC Keyper Pose Ball. Other wise you can add the AC Keyper Pose Ball 
while you are wearing your AC Keyper Doll Key. Make sure you first delete any old AC Keyper 
Pose Balls from the inventory of your your AC Keyper Doll Key. The poseball has two default 
animations that are not listed in the AC Keyper Button Configuration notecard. The animation for 
winding,'Winding' and the animation for waiting, 'Wait Stand'. If you wish to change these default 
animations simply delete the old animation and add your own. Make certain the newly added 
animation has the same name as the old animation so that the internal script will play it. When the
winding animation is played it is looped on a timer. This animation will play relative to how long the
user chose to wind the Doll.

11.2. POSEBALL USE

In order to use the AC Keyper Pose Ball you must be in an area that you are allowed to rez at. If 
the land only allows group members to rez then the Doll must be wearing the proper group tag. 
Depending on the Value for the Keyword of RezPoseBall (0 - Doll Only, 1 - Everyone, or 2 - Doll 
Owners) in the AC Keyper General Configuration notecard, a user can rez an AC Keyper Pose 
Ball by choosing PoseBall from the Public Menus. A Doll can rez a poseball by choosing PoseBall 
from the Doll Menus then choosing Rez from the Pose Ball Menu. The AC Keyper Pose Ball is 
then rezzed right behind the Doll. You can change the distance from the Doll that the poseball 
rezzes at by altering the Value for the Keyword of PoseBallOffset in the AC Keyper General 
Configuration notecard. The AC Keyper Pose Ball has a built in feature to adjust up or down 
depending on the sitter's height and the Doll's height. The AC Keyper Pose Ball also adjusts its 
position and rotation relative to where the Doll is each time someone sits on the pose ball. The 
Doll can also de-rez all AC Keyper Pose Balls by choosing DeRez from the Pose Ball Menu. A 
user can now sit on the AC Keyper Pose Ball and be animated for different options in the AC 
Keyper Public Menus. Once a user sits on the poseball, the poseball will turn invisible. When a 
user stands up, the poseball will become visible again. If the person sitting on an AC Keyper Pose
Ball is not the current user of the Doll then the person will not be animated. If this person is 
someone you do not want on your poseball at all, you can choose to DeRez all AC Keyper Pose 
Balls. AC Keyper Pose Balls will automatically de-rez when there is no sitter for ten minutes.
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12. HOW TO ENABLE RLV

RLV must be enabled in order for the ~AC~ Keyper Doll Key to work. There are two ways to 
enable RLV on third party viewers. Either via the Advanced menu or via the Preferences.

12.1. ADVANCED MENU

If the Advanced option is not already listed in your main menu then hit the following keys 
simultaneously: (Ctrl + Shift + D).
You will then see the 'Advanced' option in the menu at the top of your viewer window. Click on 
'Advanced' and a sub-menu appears. Look for the "Restrained Love API" option and if there is no 
check mark in front of it, click that option. Finally relog into Second Life in order for RLV to take 
effect.

12.2. PREFERENCES

To access the Preferences hit the following keys simultaneously: (Ctrl + P). In the window that 
appears, you will see a tab with your viewer name on it. It is the last tab down on the left side. 
Click on this tab. On the top right you will see tabs going across horizontally. Click on the tab that 
says 'Misc'. If the 'Enable Restrained Love(RLVa) features' is not turned on then do so now. 
Finally re-log into Second Life in order for RLV to take effect.
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13. WARNINGS AND NOTABLES

13.1. GENERAL

Do not wear a separate open collar with the AC Keyper Doll Key.

DO NOT update or replace the open collar scripts. Angel's Creations is a front end to these 
scripts. Updating them will cause the AC Keyper Doll Key to malfunction and break.

Do not alter the description fields or prim names of the AC Keyper Doll Key.

Always choose “Cancel”, “---”, or “-- Cancel --” from dialog menus that your are done using. This 
assists in reducing lag by shutting off internal timers and listeners. If possible, never hit the ignore 
button in dialog menus as it cannot be detected and thus timers and listeners continue to run 
producing lag and preventing others from readily using the device. This is not only true for the AC 
Keyper Doll Key but true for all dialog menus in Second Life.

Once the Doll is broken or wound down it is possible for someone to bypass the AC Keyper 
Menus via standard open collar chat commands. This means, if you have the open collar set to 
allow non-owners to interact with your open collar and the AC Keyper set to Doll Owners then 
once the Doll is broken or wound down someone can type open collar commands and access the 
Naughty feature of your AC Keyper Doll Key.

The open collar hovertext option is not available in the AC Keyper Doll Key. This is because the 
basic function of the doll key is to rotate, which will cause the hovertext to also rotate.

13.2. EXTERNAL OC DEVICES

The menu systems of open collar devices (such as AOs, owner's hud, and cuffs) can bypass the 
AC Keyper Menus. Thus, the use of such devices with the AC Keyper at the same time is 
unpredictable and not recommended.
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14. TIPS, ANIMATIONS

14.1. GENERAL

Use short animation and sound names. Use short tool names (AC Keyper 'toolname'). Use button 
names that are clever in the AC Keyper Buttons Configuration notecard. By clever I mean 
something that lets the user have an idea of what type of animation might occur or what type of 
tool they should be wearing for a Repair button choice. If the user sees the Doll is on the ground, 
then a clever Repair button name would be Kneel, or some action name.

14.2. ANIMATION RECOMMENDATIONS

If you are creating your own animations there are some things too keep in mind in order for things 
to work out visually. The Doll animations for being broken need certain restrictions. Only displace 
on the vertical axis. Towards the end of the animation make sure there is very little displacement 
on the x and y axis. Specifically displacement of the hip bone. The for the Pose Ball Fix 
animations again, very little displacement on the x and y axis. By restricting the displacement the 
Pose Ball animation will be played out right next to the broken doll, giving a better visual effect.

Recommended lengths for AC Keyper Pose Ball animations:
For the [FIX] Events: ten seconds
For the [BREAK] Events: five or less seconds
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Disclaimer: Angel's Creations is not responsible any consequences or results by the use of 
this device.

Angel's Creations Keyper Doll Key was made with the invaluable assistance of Alien Wise 
Enterprises (AWE).

For scripts, builds and custom work, please visit the main Alien Wise Enterprises (AWE) store 
at: http://maps.secondlife.com/secondlife/HV%20community/25/48/23

Thank you so much for making a purchase from Angel's Creations. We hope you enjoy your 
new product.

Please visit Angel's Creations to see all of the products we offer. If you have any questions, 
comments, or custom requests please contact AngelAcuteAngle Jupiter.

http://maps.secondlife.com/secondlife/HV%20community/25/47/23
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